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Overview

Overview
What is SSL UC1?

UC1 is a hardware control surface that provides hands on control of your favourite plug-ins. It is designed to put the fun back into
mixing, with a workflow that promotes muscle-memory operation and ultimate operator confidence. At the heart of UCT is the truly
innovative Plug-in Mixer; a place to view and control your channel strips and Bus Compressors side by side - it's like having a

virtual SSL console inside your computer.

UC1 Hardware SSL 360°-enabled plug-ins SSL 360° Plug-in Mixer

All communication is synchronised across UCT1, the plug-ins and the 360° Plug-in Mixer

SSL 360° Enabled Plug-ins UC1 Can Control

e Your favourite 3rd party plug-ins via 360 Link (included with UC1)

e Channel Strip 2 (included with UC1)

e 4K B (included with UC1)

e 4K E (available to purchase at a discounted price for UC1/UF8/UF1 customers or available via subscription)

e Bus Compressor 2 (included with UC1)

Features

e Hands on control of SSL 360°-enabled 4K E, 4K B, Channel Strip 2 and Bus Compressor 2 plug-ins.

e Hands on control of your favourite 3rd party plug-ins via the 360 Link plug-in.

e Authentic moving-coil Bus Compressor gain reduction meter, driven from the SSL Native Bus Compressor 2 plug-in.

e  SSL Plug-in Mixer provides a place to view and control your channel strips and Bus Compressors, all from one window.
e Muscle-memory operation and constant visual feedback via the smart LED rings.

e On-board display tells you which plug-ins UC1 is currently focused on.

e Load plug-in Presets and change channel strip routing directly from UC1 (360°-native plug-ins only).

e  Switch between 3 different DAWSs that are connected to the Plug-in Mixer.

e Hi-Speed USB connection to computer.

e Powered by SSL 360° Mac and PC software.

Supported DAWSs - For UC1 & The Plug-in Mixer

e Pro Tools (AAX Native) e REAPER (VST3)

e Logic Pro (AU) e LUNA (VST3)

e Cubase/Nuendo (VST3) Bitwig Studio (VST3)

e Live (VST3) e Digital Performer (VST3)
e  Studio One (VST3)
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5 Things About UC1

UC1 follows you around - like a loyal dog or trusty sidekick
Opening a 360°-enabled plug-in in the DAW automatically causes UC1 to focus on that plug-in. In VST3 DAWSs, UC1 also follows
the selected DAW track.

You don’t have to look at the computer screen to use it.
You can scroll through and select the channel strip and Bus Compressor 2 plug-in you want to control and see the DAW track name
that the plug-in is inserted on, directly from UC1.

You can operate multiple controls at once
Some plug-in controllers are restrictive because they limit you to turning one knob at a time, which isn’t very helpful when EQ'ing
a source. Thankfully, this is not the case with UC1 - move two controls at once, no problem.

The Bus Compressor Meter
The Bus Compressor meter brings a new dimension to mixing with plug-ins by providing a truly analogue experience. The meter
is driven from the Bus Compressor 2 plug-in and allows you to allows keep an eye on your compression levels.

The SSL 360° Plug-in Mixer

All of your 360°-enabled plug-ins in one place - get that big console workflow and feeling.

UC1/Plug-in Mixer DAW Integration

DAW integration between UC1/Plug-in Mixer and your DAW varies, depending on which DAW you are using. Below is a table
summarising the current levels of DAW integration.

Digital
Enhanced LUNA REAPER Studio One  Ableton Live Logic Pro Pro Tools
Performer
DAW Control (VST3) (VST3) (VST3) (VST3) (AU) (AAX)
(VST3)
DAW Volume
and Pan J J J J J J J
control
DAW Track
J J J J J J J
Colour
DAW Sends
J J J J J J J
Control
Synchronised
DAW Track J J J J J J J
Selection
DAW Solo
and Mute J J J J J J J
control
DAW Track
v J J J J J J J
Number
DAW Track
J J J J J J J J J
Name
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Get-Started

Get-Started

Unpacking

The unit has been carefully packed and inside the box you will find the following items in addition to your UC1 control surface:

12 volts, 5 A Power Supply
and IEC Cable

4 x Screws

Fitting The Stands (Optional)

MRROXY .
d o o 29
AL @Qog

Additional Elevation Angles

e -

AL

1 x Hex Key

.

1.5m C to C USB Cable 1.5m Cto A USB Cable

UC1 has been designed to be used with
or without the included screw-in stands,
depending on your preference. Attaching
the included screw-in stands has the added
benefit of angling the unit towards you.
Three different fixing positions (the holes
are arranged in pairs) allow you to choose
an angle that is best for your setup. Use 2
screws per stand. Please be careful not to
over-tighten to avoid stripping the screw
threads. For those with a torque measuring
device, tighten to 0.5 Nm.

If you need a steeper angle of elevation, you can rotate the stands and fix them to the chassis using the shorter side. This gives
you three additional angle options to choose from.

1. Unscrew the rubber feet and move to the other end

2. Rotate the stands so that the short side fixes to the chassis

SSL UCI User Guide



Get-Started

UC1 Physical Specification

Dimensions
11.8x10.5x2.47 /300 x 266 x 61 mm (Width x Depth X Height)

Weight
Unboxed - 2.1 kg / 4.6 Ibs
Boxed - 4.5 kg /9.9 Ibs

Safety Notices

Please read the Important Safety Notices at the end of this User Guide before use.

Detailed Dimensions
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Get-Started

Connecting Your UC1 Hardware

1. Connect the included power supply to the DC socket on the connector panel.
2. Connect one of the included USB cables from your computer to the USB socket.

CtoC/CtoA
USB Cable

Power Supply
gle
DC USB
UC1 Connector Panel
USB Cables

Please use one of the provided USB cables ('C' to 'C' or 'C' to 'A’) to connect UC1 to your computer. The type of USB port you
have available on your computer will determine which of the two included cables you should use. Newer computers may have 'C'
ports, whereas older computers may have 'A'. Please ensure that you are connecting to the port labelled USB on UC1, which is
a 'C' type connection.

“ SSL UCI User Guide



Get-Started

Downloading SSL 360° and 360°-enabled Plug-ins

UC1 requires the SSL 360° software to be installed on your computer in order to function. SSL 360° is the brains behind your
UC1 control surface and is also the place to access the 360° Plug-in Mixer. Once you have connected the UC1 hardware to your
computer as described on the previous page, please download SSL 360° from the SSL website. Whilst you're on the Downloads

page, also download the 360°-enabled plug-ins.

1 | SSL 360°
http:/www.solidstatelogic.com/support/downloads
. R

& =

1.  Go to www.solidstatelogic.com/support/downloads
2. Select UC1 from Products drop-down list.
3. Download the SSL 360° software for your Mac or Windows system..
4. Download 360°-enabled plug-ins and the 360 Link plug-in for your Mac or Windows system.

Installing SSL 360° Software

) & Install SSL 360° a S5L 360° Setup - X

Welcome to the SSL 360° Installer
Welcome to the SSL 360° Setup

o Introduction You will be guided through the steps necessary to install this Wizard
software.

Destination Select This wizard will guide you through the installation of S5L
Installation Type 3807,

Itis recommended that you dose all other applications
befare starting Setup, This will make it possible to update
relevant system files without having to reboot your
computer,

Click Install to start the installation.

Continue Cance
Mac Windows
1. Locate the downloaded SSL 360.dmg on your 1. Locate the downloaded SSL 360.exe on
computer. your computer.
2. Double-click to open the .dmg. 2. Double-click to run the SSL 360.exe.
Double-click to run the SSL 360.pkg. 3. Proceed with the installation, following the
4. Proceed with the installation, following the on-screen on-screen instructions.

instructions.
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Installing 360°-enabled channel strips, 360 Link and Bus Compressor 2 Plug-ins

Next, you'll need to install the 360°-enabled plug-ins. Simply locate the downloaded Installers (.dmg for Mac, or .exe for Windows)
and double-click to launch the installers. Follow the instructions.

[ X6) & Install SSL Native Channel Strip 2 macOS a @O & Install SSL Native Bus Compressor 2 macOS a

Package Name Action i Package Name Action

v @ SSL Native Channel Strip 2 . v @ SSL Native Bus Compressor 2
AAX Upgrade - AAX Upgrade
Audio Units Upgrade . Audio Units Upgrade
VST Upgrade . VST Upgrade
VST3 Upgrade . VST3 Upgrade

Space Required: 125.6 MB Remaining: 10.44 GB Space Required: 113 MB Remaining: 9.35 GB

Solid State Logic [~ Go Back | Solid State Logic "
Go Back

On Mac, you can choose which of the available plug-in formats to install (AAX Native, Audio Units, VST and VST3)

[ NON ] [ SSL Native Channel Strip 2 macOS Installer
. . . . X 2 items - r——
If you are using Logic with a Mackie Control
Surface (such as UF8), then install the Logic - v
Essentials .dmg which contains the MCU Logic Essentials SSL Native Channel Strip 2

. . macOS Installer.pkg
mappings for the plug-ins.

L SSL Native Channel Strip 2 macOS Installer

General System Requirements
Computer operating systems and hardware are constantly changing. Please search for 'UC1 Compatibility' in our online FAQs to

check if your system is currently supported.
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Get-Started

Redeeming and Authorising Your Plug-in Licenses

You'll need to register your UC1 hardware in the SSL user portal to claim your plug-in licenses that are included with UC1.

http:/www.solidstatelogic.com/get-started

To register your UC1, head to www.solidstatelogic.com/get-started and follow the on-screen instructions to create an account
or log into your existing one.

Solid State LOgiC 2 MyAccount @ Logout

Dashboard

REGISTER PRODUCT

Your Products

Have a question?

Once logged into your account, click on REGISTER PRODUCT on the Dashboard page and on the following page choose
REGISTER HARDWARE PRODUCT.

Solid State Logic 55 Dashboard & MyAccount @ Logout

Register a new product

PRODUCT

SsLuUCT

nnnnnnnnnnn
2021-05-06
COUNTRY OF PURCHASE

Country

PRODUCT SERIAL NUMBER

SERIAL NUMBER

Choose SSL UC1 and complete the form.

SSL UC| User Guide



https://www.solidstatelogic.com/get-started

Get-Started

You will need to input the serial number of your UC1. This can be found on the label on the base of your UC1 unit (it is not the
number on the packaging box).

% 1XX-000115-C1D45DCYQ3L4

For example, XX-000115-C1D45DCYQ3L4. The serial number is 20 characters long, containing a mixture of letters and digits.

YOUrPrOdUCtS REGISTER PRODUCT

Have a question?

Click here to visit our Support
FAQs

READ MORE

SSLUC1

;) Download User Guide
® Watch Product Tutorial Videos
¢» Download SSL 360°

¢ Get Your Additional Software

Once you have successfully registered your UC1, it will appear in your Dashboard. Click Get Your Additional Software.

Solid State Logic 53 Dashboard & MyAccount (% Logout

®

Bundled Software

VALIDATE YOUR ILOK ACCOUNT

SSL UC1 Bundle - Channel Strip 2 and Bus Compressor 2
O) NATIVE

Channel Strip 2 Included with every UC1 are licenses for SSL Native Channel Strip 2 and Bus
Bus Compressor 2 compressor 2.

Follow the steps below to redeem your licenses. VALIDATE

SSL Native plug-ins are protected with iLok software licensing, you'll need to
create an iLok account and download iLok license manager to authorise the

licenses onto your computer or physical iLok dongle. Please do the following:

1. Create an iLok account

2. Download and install iLok License Manager software

3. Enter your iLok account user name in the box opposite on this page and click
‘Validate iLok account'. If successful click ‘Deposit Licenses’

4. Open iLok License Manager and authorise your SSL Native Plug-in licenses
onto your computer or physical iLok

5. Download and install the SSL Native Channel Strip 2 and Bus Compressor 2

plug-in installers from the Downloads page.

On this page, enter your iLok User ID into the box, wait for your iLok account to be validated and then click DEPOSIT LICENSES.
Repeat this process for the 4K B entry box that will be underneath the Channel Strip 2 and Bus Compressor 2 box.

SSL UCT User Guide
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Finally, open iLok License Manager, locate the UC1 Channel Strip 2 and Bus Compressor 2 licenses and right-click Activate onto
your computer or physical iLok.

4K B will appear as a separate license. Locate it in iLok License Manager, then right-click to Activate onto your computer or
physical iLok.

iLok License Manager

All Licenses (98) = Available (27) All Activations (84) Unavailable (34) ' Hidden (0)

Valid Locations Product Name Publisher Name  Subtype Expiration Date

i O ¥ UC1 Channel Strip 2 and Bus Compressor 2 (2) Solid State Logic Locked Group

. . : . Show Details a8l
SSL Native Channel Strip Solid State Logic Product Hide Details 2%l
SSL Native Bus Compressor Solid State Logic  Product
Activate 0-88A
D o P o A - PRV | P [ ) ) At 1 malead N

360 Link and 4K E Plug-ins

The 360 Link plug-in is license-free and available to download from the SSL website.

4K E is available to all UC1/UF8/UF1 customers at a discounted price. Please read this FAQ for more information.

SSL UCI User Guide


https://support.solidstatelogic.com/hc/en-gb/articles/16474197652253-UC1-UF8-UF1-4K-E-plug-in-discount

Product Overview & Features

UC1t

Front Panel

You can think of UC1 as two plug-in controllers in one, with the left and right hand sides dedicated to controlling 360°-enabled

channel strips / 360 Link-hosted plug-ins and the middle section controlling Bus Compressor 2.

Bus Compressor 2

trol d Met
Channel Strip Input Controls and Meter Channel Strip Output

Metering and Trim Control Metering and Trim Control

BUS COMPRESSOR OUTPUT COMPRESSOR

rastarrack [

0 A
dB
\CDMF‘RESSION PEAK .

FILTERS

.

. .

. .

. ®
THRESHOLD MAKE UP
.
O § O
ATTACK RELEASE
.
THRESHOLD
RATIO IN -

o FOTO | o (.~ ©

GAIN S/C HPF MIX GAIN

GATE/

. FAST ATTACK
EXPANDER

MAIN

—e COWBELL CHANNEL
+9.6dB
ST

CHANNEL 4= CONFIRM ROUTING PRESETS

Channel Strip Filters & EQ Central Control Panel Channel Strip Dynamics &
Controls Solo, Cut and Fine Controls
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Product Overview & Features

Smart LED Rings

Each channel strip and Bus Compressor 2 rotary control on UC1 is accompanied by a smart LED ring, which represents the knob
position in the plug-in.

Smart LED rings on UC1 Channel strip plug-in controls

The Virtual Notch

Channel strip GAIN controls for the EQ bands, Input and Output Trim all have an in-built 'virtual notch'.
Although there is no physical difference, the software that drives UC1 helps you to 'feel' your way back
to 0 dB - making it easy to flatten an EQ band from the UC1 hardware. The smart LED(s) also dim in
this position.

The Channel Strip and Bus Compressor IN Buttons

The large square IN buttons on UC1 control the DAW's Bypass function for that channel strip and Bus Compressor 2 instance. i.e.
when they are switched out, the plug-in is bypassed. Bypassing the channel strip, Bus Compressor or even just the EQ/Dynamics
section will also cause the LEDs on UC1 to dim, to help identify the bypassed state. Dimming does not apply for 360 Link-hosted
plug-ins.

CHANNEL

Channel Strip IN controls plug-in Bypass

RELEASE

Channel Strip Dynamics Metering

Two vertical arrays of five LEDs on the right-hand side show the . IN]
compression and gate activity for the selected channel strip plug-in on

the UCT front panel.

Channel strip Dynamics activity is shown on the

At this time, 3rd plug-ins hosted in 360° Link do not display dynamics right-hand side of UC1

metering on UC1.

SSL UCI User Guide




Product Overview & Features

Bus Compressor Meter

The most striking aspect of the UC1 front panel is the inclusion of a genuine moving-

BUS COMPRESSOR

coil gain reduction meter. This shows the gain reduction activity of the selected Bus
Compressor 2 plug-in. The meter is driven digitally from the plug-in and provides a
helpful way of being able to keep an eye on compression activity, even with the Plug-in

GUI closed.
dB

COMPRESSION

X

Output GAIN control

Controls the output fader of the 360°-enabled channel strip plug-in, or, the DAW fader The Bus Compressor meter
(compatible VST3 DAWSs only). With 360°-Link you can assign any 3rd party plug-in
parameter to this control.

You can choose between Plug-in or DAW control using the PLUG-IN parameter (on/off)
in the Extended Functions menu on UC1. Or you can change the parameter using the
PLUG-IN and DAW fader buttons in the Plug-in Mixer.

SOLO and CUT Buttons

The SOLO and CUT buttons apply to the channel strip
instance being controlled by UCT.

In some DAWSs, the SOLO and CUT buttons directly control
the DAW's Solo and Mute buttons. In others, the soloing
system is independent.

Please go to Page 22 for more information on the soloing

system
SOLO, CUT and FINE controls in the bottom-right of UC1
SOLO AND CUT linked to DAW SOLO AND CUT independent of DAW
Live Pro Tools
Studio One Logic Pro
REAPER
Cubase/Nuendo
LUNA
Bitwig Studio
Digital Performer
SOLO CLEAR

Clears any active Channel Strip solos.
FINE BUTTON

FINE - puts all front panel Channel Strip and Bus Compressor rotary controls into a finer resolution, for mix critical tweaks. This can
be latched or held for a momentary action.
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Product Overview & Features

Central Control Panel

The Central Control Panel of UC1 is used to perform a number of key functions relating to the plug-ins and the Plug-in Mixer.

I 13

3 )cs2

—eo COWBELL | 4
+9.6dB

5 STEREO BUS

-20dB

CHANNEL <= CONFIRM ROUTING PRESETS

1 - 7-Segment Display
Displays the position of the selected channel strip plug-in in the Plug-in Mixer.

2 - CHANNEL Encoder
Changes the selected channel strip plug-in being controlled by UCH.

3 - Channel Strip Model / 360°-Link Hosted Plug-in Name
Displays the 360°-enabled channel strip model being controlled by UC1 or, 360°-Link Hosted plug-in name.

4 - Channel Strip Name
Displays the name of the DAW track the channel strip plug-in is inserted on in the DAW. Immediately below, a value readout is
temporarily displayed whilst a channel strip control is being adjusted.

5 - Bus Compressor Name
Displays the name of the DAW track the Bus Compressor 2 plug-in is inserted on in the DAW. Immediately below, a value readout
is temporarily displayed whilst a Bus Compressor control is being adjusted.

6 - Secondary Encoder

By default this control changes the selected Bus Compressor but it can also be used to change the process order for channel
strip (ROUTING), select PRESETS or navigate the DAW's playhead cursor when in TRANSPORT mode (accessed by pushing
the encoder from Bus Comp mode). TRANSPORT mode requires HUI/MCU setup, detailed in this User Guide.

7 - BACK Button

From the MAIN screen, pushing the back button will take you to the EXTENDED FUNCTIONS menu for channel strips.
Otherwise, it is used to navigate back up through the PRESETS list or, when in TRANSPORT mode, this functions as the Stop
command.

8 - CONFIRM Button

When in the EXTENDED FUNCTIONS menu, can be used to confirm the parameter selection. Also used to navigate forward
through the PRESETS list or confirms preset loading. When in TRANSPORT mode, this functions as the Play command.

SSL UCIT User Guide




Product Overview & Features

9 - ROUTING Button
Allows the Secondary Encoder to change the processing routing order of the selected channel strip plug-in.

10 - PRESETS Button
Allows the Secondary Encoder to load a preset for the selected channel strip or Bus Compressor 2 plug-in.

11 - 360° Button
Opens/minimises the SSL 360° software on your computer screen.

12 - Zoom Button
Toggles the Bus Compressor sidebar of the Plug-in Mixer.

- In VST3 compatible DAWSs, the white bar will reflect the DAW track colour.

Extended Functions Menu

From the MAIN screen, pushing the BACK button will take you to the EXTENDED FUNCTIONS menu for channel strips. This menu
hosts any additional parameters of the selected channel strip plug-in such as Compressor Mix, Pre In/Out, Mic Gain, Pan, Width,
Output Trim and Solo Safe (exact list depends on the parameters of that particular 360°-enabled channel strip plug-in). Quick
Controls for 360°-Link hosted plug-ins are also found in here. Furthermore, the EXTENDED FUNCTIONS menu also includes the
option to switch the Output Gain control between the plug-in's own fader and the DAW in compatible VST3 DAWs.

To select and adjust a parameter, follow the steps below:

MAIN EXTENDED FUNCTIONS

o COWBELL

5

MIX BUS 892"

———e COWBELL

COMP MIX
PAN

BUS BUS
ComP compP

CHANNEL <= CONFIRM ROUTING PRESETS CHANNEL <= CONFIRM ROUTING PRESETS

1 - Main Menu - Press Back Arrow to enter (or exit) the Extended Functions 2 - Turn Secondary Encoder to move through list of functions

Menu Screen

EXTENDED FUNCTIONS

e — COWBELL
. COMP MIX
s c o PAN
* WIDTH

| EXTENDED FUNCTIONS |

e— COWBELL (\
. COMP MIX
WIDTH

BUS
COMP

BUS
COMP

CONFIRM CHANNEL <= CONFIRM ROUTING PRESETS

CHANNEL <=

ROUTING PRESETS

4 - Turn Secondary Encoder to adjust selected function.
Press encoder to go back to scrolling Extended Functions Parameter List

3 - Press Secondary Encoder to select function from the list to adjust

Don't forget, that you can use the FINE button to increase the resolution of control when
adjusting any Extended Functions parameter.
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Product Overview & Features

Process Order Routing

You can adjust the process order routing for the selected 360°-enabled channel strip plug-in by pressing the ROUTING key and
then turning the secondary encoder.

There are 10 possible routing orders, as shown in the ROUTING

table below. Each routing order has a 'b' equivalent,
which sources the Dynamics sidechain externally. COWBELL

Processing Order Options --
. Filters > EQ > Dynamics (Default) E m 1

. EQ > Filters > Dynamics

. Dynamics > EQ > Filters

. Filters > Dynamics > EQ

. Filters > Dynamics > EQ (with Filters to DYN S/C)
. Filters > EQ > Dynamics (with EQ to DYN S/C)

. Filters > EQ > Dynamics (with Filters to DYN S/C)

. EQ > Filters > Dynamics (with EQ and Filters to DYN <4== CONFIRM ROUTING PRESETS

S/C)
9. EQ > Filters > Dynamics (with EQ to DYN S/C) Press ROUTING then use the secondary encoder to select the

10. EQ > Dynamics > Filters (with DYN and Filters to DYN S/C) process ordering for the selected channel strip plug-in
To return the secondary encoder to controlling the selected Bus Compressor,

0 N O oM~ WD =

simply press the ROUTING key again.

'b' equivalent - the top line going into Dynamics means
that the Dynamics sidechain is set to EXTERNAL

360°-Link hosted plug-ins do not support the ROUTING or PRESETS menu

Presets

You can load presets for the selected channel strip or Bus Compressor 2 plug-in directly from the surface by pressing the PRESETS
key. Turn the secondary encoder to choose if you want to load a preset for the selected channel sttrip or Bus Compressor and
confirm by either pushing the secondary encoder, or pressing the CONFIRM button. Then use the secondary encoder to scroll

through the list of presets. Pushing will either confirm the current preset (it turns green), or it will enter you into a preset folder. Use
the BACK ARROW key to navigate back up through preset folders. Press PRESETS once more to return the secondary encoder
to controlling Bus compressor selection.

PRESETS

CHANNEL STRIP

PUSH TO CONFIRM
CHANNEL STRIP

4== CHANNEL STRIP

<= CONFIRM  ROUTING  PRESETS <= CONFIRM  ROUTING  PRESETS
Press the PRESETS key and then choose channel strip Navigate through your presets list using the
or Bus Compressor secondary encoder and push to load
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Transport

You can control the DAW's Play and Stop commands, as well as the playhead cursor from the front panel of UC1. The Transport
functionality from UC1/Plug-in Mixer is achieved using HUI/MCU commands. In order for this to function, you must configure a HUI/
MCU controller in your DAW, as well as configuring which DAW is driving the Transport in the CONTROL SETUP tab of SSL 360°.

Please follow the instructions in the Plug-in Mixer Transport Setup section if you want to use TRANSPORT
Mode on UCH.

1 - Ensure you are in Bus Comp mode and then simply press the Secondary Encoder to enter/exit TRANSPORT mode.

2 - Turning the Secondary Encoder will allow you to navigate the playhead cursor forwards/backwards along the DAW's timeline.
3 - The BACK button becomes the STOP command.

4 - The CONFIRM button becomes the PLAY command.

TRANSPORT

————eo COWBELL

BUS
COMP

CHANNEL <= CONFIRM ROUTING PRESETS

Connector Panel

The recessed section hosts UC1's connectors.

@

O,

1 - DC Connector
Use the included DC Power Supply to provide power for your UC1.

2 - USB - 'C' Type Connector
Connect one of the included USB cables from your computer to the USB port on UC1. This handles all of the communication
between the plug-ins and UC1, via the SSL 360° software application.

SSL UCT User Guide




Product Overview & Features

UC1/360°-Enabled Channel Strip Plug-ins

Below are the channel strip plug-ins that currently integrate with UC1 and the SSL 360° Plug-in Mixer.

COMPRESSOR MIX

FasT

Channel Strip 2 f—

Included with UCT At i wo

INTRIM

In-depth User Guide available on the SSL Support Site. . (TY:

Channel Strip 2 is a fully-featured channel strip, based
on digital modelling of the EQ and Dynamics curves from
the legendary XL 9000 K SuperAnalogue console. Clean,
linear tone shaping for maximum flexibility. Switch between
classic E and G-Series EQ curves.

The V2 update adds:

e Re-designed GUI

e HQ Mode - Intelligent Oversampling

e Qutput Fader

e Width and Pan Controls for Stereo Instances

4K B

Included with UC1
In-depth User Guide available on the SSL Support Site.

The 4K B is a detailed model of the legendary SL 4000 B
channel strip. The SL 4000 B was the first ever commercially
released SSL console and responsible for the sound of
many classic records that came out of London's famous
Townhouse Studio 2, 'The Stone Room'.

e Full of tone, punch and rich non-linear analogue
character

e Add analogue saturation and drive to your tracks with
the pre-amp section and VCA fader saturation

e Original 4000-series EQ circuit, the precursor to the O2
Brown Knob EQ of the 4000 E

e B-Series channel compressor, featuring a circuit

topology that is based on the SSL Bus Compressor —
peak detection and a sidechain VCA in a feedback loop
e Unique ‘ds’ mode re-purposes the compressor to be a de-esser.

SSL UCI User Guide


https://support.solidstatelogic.com/hc/en-gb/sections/4407582196893-Plug-in-User-Guides
https://support.solidstatelogic.com/hc/en-gb/sections/4407582196893-Plug-in-User-Guides

Product Overview & Features

4K E

4K E is available to all UC1/UF8/UF1 customers at a discounted price. Please read this FAQ for more information.
In-depth User Guide available on the SSL Support Site.

The 4K E Plug-in is the definitive software emulation of the
4000E console channel strip, authentically recreating the
sound, processing and workflow of one of the most highly
regarded and influential music production tools in history.
Released in 1979, the 4000E console played a pivotal role in
reshaping the way music was made. Its big, punchy sound,
advanced processing tools and ground-breaking flexibility
meant it quickly became the tool of choice for the world's
top studios.

e The sought after signature SSL sound; the sound of hit-
records

e Jensen JT-115K-E mic pre with adjustable saturation

e Choose between Brown, Black and the rare ‘passive-
style’ Orange EQ flavour

e Revision 4 Dynamics — the classic Soft-knee and
logarithmic release circuit
e DBX 202 Gold Can fader

360 Link

The 360 Link plug-in is license-free and available to
download from the SSL website.

In-depth User Guide available on the SSL Support Site
or view our 360 Link YouTube Tutorial on the SSLVideos
channel. Both include details on mapping your 3rd party

& SSLNTUX-uLUCOMPUS (53]

% Favourites

plug-ins to UC1's channel strip controls. e

bx_console SSL 9000 J
Pro-C2

SSL EV2 Channel Mono
your hybrid SSL workflow by allowing effortless control of any fe UAD SSL E Channel Strip
third-party plug-in using the UC1/UF8/UF1 hardware. bt ab e

Virtual Mw.[satk

SSL 360 Link brings a new level of power and flexibility to

Open Plug-In Library

e  Control any 3rd party plug-in with UC1.
e Choose from a selection of editable factory control

SOLID STATE LOGIC e 360° LINK.

maps for Slate Digital®, Universal Audio®, Waves®,
Brainworx® and Harrison Audio® plug-ins.

e  Customise your mixing experience by creating control
maps for any plug-in.

e Optimize workflow efficiency by centralizing control
within the SSL 360° ecosystem.

e Insert empty 360° Link plug-ins on every channel as an efficient way of adding VST3 DAW control (pan, fader, track colours,
sends etc) for UC1/UF1/UF8. Compatible VST3 based DAWSs only.
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Channel Strip Plug-in User Guides

For in-depth information on all features of the channel strip plug-ins, please refer to the individual plug-in user guides on the SSL
Support Site. This User Guide focuses on UC1 and Plug-in Mixer integration with the channel strip plug-ins.

Plug-in Mixer Number, Track Name and 360° Button —
The 3-digit number in red tells you the position that the channel strip plug-in has
been assigned to in the 360° Plug-in Mixer. To the right of this is the name of the

DAW track the plug-in is inserted on - e.g. 'LEADVOX'. The button labelled 360° opens the SSL 360° on the Plug-in Mixer page
(presuming SSL 360° is installed). Otherwise, it will take you to the SSL website.

SOLO, CUT & SOLO CLEAR

In some DAWSs, the SOLO and CUT buttons directly control the DAW's Solo and Mute buttons. In others, the soloing system is
independent.

SOLO AND CUT linked to DAW SOLO AND CUT independent of DAW

Live Pro Tools
Studio One Logic Pro
REAPER
Cubase/Nuendo
LUNA
Bitwig Studio
Digital Performer

For DAWs whereby the SOLO and CUT integration is independent (not linked to the DAW), this is how it works:
SOLO - Cuts the output of all other channel strip plug-ins in the session.

CUT - Cuts the output of the channel strip plug-in.

SAFE - Prevents the plug-in from being cut in response to another channel strip in the session having its SOLO
activated. Useful for when channel strips are inserted onto Aux/Bus tracks within the session. This button is
only available for Pro Tools, Logic, Cubase and Nuendo.

Recommended workflow when SOLO and CUT are independent of DAW:

1. Insert a 360°-enabled channel strip plug-in on all tracks in your DAW session.

2. Make sure to engage the SOLO SAFE button on channel strips that have been inserted onto Auxes/
Busses/Sub Groups/Sub Mixes. This will ensure that you hear individual instruments that are routed to
these destinations when you start soloing.

SOLO SAFE prevents a channel strip from being cut when another channel strip's SOLO is activated.

SOLO CLEAR
Clears any active Channel Strip solos.

Version Number

In the bottom-right of the plug-in GUI, the version is displayed e.g. 2.0.27 This is important _
to pay attention to because SSL 360° releases will often require a certain version of plug-in
to be installed in order for the system to function correctly. Please check the SSL 360°
Release Notes article on the SSL knowledge base to check you are running compatible
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Bus Compressor 2

The Bus Compressor 2 plug-in is based on the legendary
centre section bus compressor found on SSL's large format
analogue consoles. It provides high quality stereo compression
for critical control over the dynamic range of audio signals.

CCOMPRESSION

The compressor can be used for practically any application
that requires superior compression. For example, place it over
a stereo mix to ‘glue’ the mix together whilst still maintaining a
big sound, or use it on drum overheads or whole drum kits for
highly effective control of drum dynamics.

Track Name and Plug-in Mixer Button
Beneath the Oversampling options, the DAW's Track Name is displayed.

Below this, there is a button labelled PLUG-IN MIXER that opens the SSL 360° on the Plug-in
Mixer page (presuming SSL 360° is installed). Otherwise, it will take you to the SSL website. e
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SSL 360° Software

Home Page

SSL 360° software is not only the 'brains' behind the UC1 control surface, it is also the command centre from which new versions
of software and firmware can be downloaded for your 360° compatible device. Importantly for UC1, SSL 360° hosts the Plug-in
Mixer page.

[} [} SSL 360°

Solid State Logic
g‘i_l) SSL 3

SsLuUC1
UC-008337

5 6 7 8 9

lid

Sleep Settings  About s&‘; The SSL Website @ SSL Support SSL Instagram f SSL Facebook Export Report  v1.6.12.56177

The HOME screen:

1 - Menu Toolbar
This toolbar allows you to navigate through the various pages of SSL 360°.

2 - Software Updates Area
When software updates become available, an Update Software button will appear here (not shown in the image above). Click this
to download and update your software.

3 - Connected Units
This area shows any 360°-enabled devices that are connected to your computer, along with their respective serial numbers. Please
allow 5-10 seconds for units to be discovered once they are plugged in.

If your unit(s) are not showing up, try unplugging and re-plugging the USB cable from the port on your computer.
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4a - Firmware Updates Area

If a firmware update becomes available for your UC1 unit, an Update Firmware button will appear on top of the UC1 icon (not
shown in the image). If present, click on the button to start the firmware update process, being sure to not disconnect the power
or USB cable(s) whilst it is in progress.

4b - UC1 Bus Compressor Meter Calibration

Meter Calibration

Calibrate VU-Meter

Providing your UC1 firmware is up-to-date, you can hover over the UC1 icon and click
'Calibrate VU-Meter' to access the Meter Calibration tool.

SSL UC1

This tool will enable you to (if necessary) calibrate the physical Bus Compressor meter, gl o

so that it closely matches the Bus Compressor 2 plug-in.

UC1METER CALIBRATION

For each calibration marking use the - and + buttons to move the Bus Compressor UCHENS o oaaon
meter on the UC1 hardware, until it lines up closely with the marking. Meter Calibration

\ i /
The calibration is saved automatically onto the UC1 hardware. ) \ 1

Choose Calibration Marking

Adjust hardware need|

5 - Sleep Settings / UC1 Screen-saver
Clicking this will open a pop-up window that allows you to determine HARDWARE SLEEP SETTING
the length of time before your connected 360° control surfaces go into
Sleep mode. Simply click your mouse in the green digit area and type [=] Enable Hardware Sleep Mode After 30 Minutes
a number between 1 and 99. To force a control surface out of sleep
mode, press any button or move any control on the surface itself. You

can untick the box to disable Sleep mode.

6 - About
Clicking this will open a pop-up window detailing software licensing relating to SSL 360°.

7 - SSL Socials
The bar at the bottom has quick links to the SSL website, Support section and SSL Socials.

8 - Export Report

Should you encounter any issues with your SSL 360° software or control surfaces, you may be asked by a support agent to use
the EXPORT REPORT feature. This feature generates a text file containing essential information about your computer system and
UF8(s)/UCH1, alongside technical log files relating to SSL 360° activity, which may help to diagnose any issues. When you click
EXPORT REPORT, you'll be asked to choose a destination on your computer to export the generated .zip file to, which you can
then forward on to the support agent.

9 - SSL 360° Software Version Number
This area displays the version number of SSL 360° that is running on your computer. Clicking on the version text will take you to
the Release Notes information on the SSL website.
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Control Setup Page

This is accessed via the settings cog icon on the left-hand side toolbar in 360°.

Plug-in Mixer Transport

Determines which DAW drives the Plug-in Mixer Transport control
via HUI/MCU. Please read the Transport Control section for more
information on configuring this.

TRANSPORT
SETUP

Controller Settings

CONTROLLER
SETTINGS

CONTROL SURFACES BRIGHTNESS
Choose from 5 different brightness options for your connected 360°-enabled controllers (UF8/UF1/UC1). The brightness adjusts
both the displays and buttons. This is useful for dark studio environments, where the default 'Full' settings might be too bright.

CONTROL SURFACES SLEEP TIMEOUT (mins)

Determines the length of time before your connected 360° control surfaces go into Sleep mode. Simply type a number between

1 and 99. To force a control surface out of sleep mode, press any button or move any control on the surface itself. You can untick

the box to disable Sleep mode.
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Plug-in Mixer

The Plug-in Mixer is a place to view and control 360°-enabled plug-ins (including 3rd party plug-ins hosted in 360 Link) from your
DAW session. It's like having access to your own virtual SSL console in your computer! Best of all, the Plug-in Mixer is available
to everyone who uses 360°-enabled plug-ins, serving as a way of enhancing your workflow. Also, it does not require UC1 to be
connected, meaning that if you're unable to take your hardware with you on the road, you can still enjoy the experience of the

Plug-in Mixer

Options Menu

PLUG-IN MIXER

[a] Auto Select
(=] Auto Scroll
[=] Transport

[=] Colours

—— HOST —

® Pro Tools

ssL.360°

011030460 [|RIE R BB E S

< oveRv
DRUM

ew > ReseT
1 -1.6
40 -32
-13.9
-151 149
x on-Lies
Kevs

™ N

Auto Select
With Auto Scroll enabled, adjusting a channel strip plug-in parameter will cause that particular instance of
channel strip to become the selected one in the Plug-in Mixer/UC1.

Auto Scroll
With Auto Scroll enabled, the Plug-in Mixer window will automatically scroll to make sure the selected

instance of channel strip is visible on screen.

Transport
Shows/hides the Transport Bar.

Colours
Shows/hides the DAW Track Colour segments (VST3-compatible DAWSs only)

HOST

Allows you to switch control between up to 3 different host DAWSs that are connected to the Plug-in Mixer.
When channel strip and/or Bus Compressor 2 plug-ins are inserted in your DAW, they trigger that DAW to
come online as a HOST in the Plug-in Mixer. Clicking on the appropriate HOST button will switch the Plug-in
Mixer (and UC1) to control that DAW.
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Channel Strip Metering

1 - Expands/collapses section
2 - Toggles between channel strip Input or Output Metering

Centre Section Sidebar
CENTRE SECTION

Expands/collapses the Centre Section sidebar that
contains Bus Compressor 2 and SSL Meter instances.

Pan & Fader

The PLUG-IN and DAW buttons in the fader tray section toggle the Plug-in Mixer between controlling the plug-in's own fader and
pan, or, the DAW's fader and pan (compatible VST3 DAWSs only).

PLUG-IN
selected

DAW

—
selected
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Adding/Removing Channel Strips to the Plug-in Mixer

Plug-ins are automatically added to the Plug-in Mixer when you instantiate them in the DAW session. Deleting a plug-in in the DAW
session will remove it from the Plug-in Mixer.

Channel Strip Ordering in the Plug-in Mixer

The way in which the Plug-in Mixer works varies between DAWSs. All supported DAWSs allow the DAW track name to be 'pulled
through' so that the channel strip is automatically labelled, however, the way in which channel strips are ordered in the Plug-in
Mixer depends on the DAW:

DAW Plug-in Mixer Ordering

Pro Tools Instantiation Time + Manual

Logic 10.6.0 and below Instantiation Time + Manual

Logic 10.6.1 and above Automatic

LUNA 1.4.5 and below Instantiation Time + Manual

LUNA 1.4.6 and above Automatic (must use VST3s)

Cubase/Nuendo Automatic (must use VST3s)

Live Automatic (must use VST3s) Fesiiien fin
Studio One Automatic (must use VST3s) Plug-in Mixer
REAPER Automatic (must use VST3s)

Bitwig Studio Automatic (must use VST3s)

Digital Performer Automatic (must use VST3s)

Instantiation Time + Manual

For DAWSs that fall into this category, Channel Strips are added sequentially to the r B -

Plug-in Mixer, based on when they were inserted into the DAW session. You can re- O MIXBUS
order channel strips in the Plug-in Mixer by clicking and dragging in the track :
name area.

. Click and drag in the Track Name area
Automatic to re-order in non-automatic DAWs
For DAWSs that fall into this category, the ordering of channel strips in the Plug-in Mixer will (Pro Tools, Logic 10.6.0 and below)
dynamically follow the order of the tracks in your DAW session. You cannot manually re-

arrange channel strips in this mode.
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Logic Pro 10.6.1 and above - Aux Tracks

Aux Tracks in Logic do not initially provide the Plug-in Mixer with a
DAW track number. As a result, the Plug-in Mixer will position Aux
tracks on the right-hand end of the Plug-in Mixer automatically.
However, if you wish to allow Aux Tracks to dynamically update their

position in the Plug-in Mixer (like with Audio and Instrument tracks), > | B | -
Create Track

then in Logic right-click Create Track on each one. This will add it to 311 Create New VCA
Assign Channel Strip Color...
Rename Channel Strip...

the Arrangement page, which will then enable the Plug-in Mixer to
synchronise with the Logic track number - meaning that Aux tracks
will also follow the order of your Logic session.

Channel Strip Components »
Configure Channel Strip Components... XX
Store as User Default

Apply User Default

Revert to Factory Default
Small Large maiy  smai [ai; - Ameience; smai Fiate/ [Stel
Room/0.6s 4.7s Prison 1.6s Short 0.2sLong 1.1s Vocal
Dru...Four Main Floor Vocal Hall Ambience Plate

<

In the Logic Mixer, right-click in the track name area and
select 'Create Track'

Logic Pro 10.6.0 and below - Disable Dynamic Plug-in Loading

We recommend that you use Logic 10.6.1 with the UC1 and Plug-in Mixer system, however, if you are using Logic 10.6.0 or below,
it is important that you disable Dynamic Plug-in Loading at the start of each project as it can cause issues. This step does not
apply if you are using 10.6.1.

Go to File > Project > General and un-tick Only load plug-ins needed for project playback.

B Logic UC1 - Project Settings

» 2 A B @cs@s ="

Synchronization Metronome Smart Tempo Recording Tuning Audio MIDI Score Movie Assets
Project Type: v Use musical grid
The primary ruler displays Bars and Beats. Tempo information is recorded in audio files.
Opening Project

Only load plug-ins needed for project playback

Automation

v Region automation takes priority over track automation

Use preset parameter value for regions without region automation (if no track automation is present)

Logic 10.6.0 and below users, make sure that 'Only load plug-ins needed for project
playback' is un-ticked at the start of each project
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Adding/Removing Bus Compressors to the Plug-in Mixer

Plug-ins are automatically added to the Plug-in Mixer when you instantiate them in the DAW session. Deleting a plug-in in the DAW
session will remove it from the Plug-in Mixer.

Bus Compressor 2 Ordering in the Plug-in Mixer

Bus Compressor plug-ins appear on the right-hand side of the Plug-in Mixer, as they are added to the DAW session. Up to 8 Bus
Compressors can appear in the list and therefore 8 can be switched between on UC1. The DAW session itself can have as many
Bus Compressor 2 plug-ins as you like but if you've reached 8 in the Plug-in Mixer, you'll need to delete some to get access to
them again on UC1. It is not possible to re-order Bus Compressors in the sidebar.

Selecting a Channel Strip

To select a channel strip in the Plug-in Mixer, simply click anywhere on the strip's
background. There are other ways of selecting a channel strip, which include
using the CHANNEL encoder on the UC1 hardware, opening the plug-in GUI in
the DAW session and in certain supported DAWSs, selecting the DAW track.

Selecting a Bus Compressor

To select a Bus Compressor in the Plug-in Mixer, simply click on the meters of the
Bus Compressors on the right-hand side. There are two other ways of selecting a
Bus Compressor, which are using the secondary encoder on the UC1 hardware,
or simply opening the plug-in GUI in the DAW session.

DYNAMICS

100.6% MIX 1808% MIX
FasT B

PK! ‘ ‘
- -

b N

ot -

\ DRUMBUS SUBMIX

MIXBUS

N NS

{3 o "ot
2t 20 DRUM PARALLEL MIX BUS

THF

Selected channel strip & Bus
Compressor has a blue outline
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Follow DAW Track Selection

Synchronisation of the selected DAW track and the Plug-in Mixer is available for the following DAWS:
e Cubase/Nuendo
e Ableton Live

e  Studio One
e REAPER
e LUNA

e Bitwig Studio
e Digital Performer

SOLO, CUT & SOLO CLEAR

In some DAWSs, the SOLO and CUT buttons directly control the DAW's Solo and Mute buttons. In others, the soloing system is
independent.

SOLO AND CUT linked to DAW SOLO AND CUT independent of DAW

Live Pro Tools
Studio One Logic Pro
REAPER
Cubase/Nuendo
LUNA
Bitwig Studio
Digital Performer

® Kickln  ® KickOut O
For DAWs whereby the SOLO and CUT integration is independent (not linked T
to the DAW), this is how it works:

SOLO - Cuts the output of all other channel strip plug-ins in the session.

&

CUT - Cuts the output of the channel strip plug-in.

SAFE - Prevents the plug-in from being cut in response to another channel
strip in the session having its SOLO activated. Useful for when channel
strips are inserted onto Aux/Bus tracks within the session. This button is only

available for Pro Tools, Logic, Cubase and Nuendo.
SOLO CLEAR
BUTTON

Recommended Workflow when SOLO and CUT are independent of DAW:

1. Insert a channel strip plug-in on all tracks in your DAW session.
2. Make sure to engage the SOLO SAFE button on channel strips that have been inserted onto Auxes/Busses/Sub Groups/
Sub Mixes. This will ensure that you hear individual instruments that are routed to these destinations when you start soloing.

SOLO SAFE prevents a channel strip from being cut when another channel strip's SOLO is activated.

SOLO CLEAR
Clears any active channel strip solos.
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Plug-in Mixer Keyboard Shortcuts

Some useful keyboard shortcuts you can use in the Plug-in Mixer.

Action Keyboard Shortcut
Space Bar Transport: Play/Stop*
Z Transport: Rewind*
X Transport: Forward*
R Transport: Record”
L Transport: Loop/Cycle*
D Toggles Pan and Faders between PLUG-IN and DAW
C Solo Clear
1 Zoom: Default
2 Zoom: Overview
Bypass Channel Strip Alt+Mouse Click
Move Plug-in Mixer Up/Down/Left/Right Up, Down, Left, Right
Fine Control of Knobs CTRL + Mouse click and drag

*Requires Transport Control to be configured.

SSL UCI User Guide




Product Overview & Features

Restrictions and Important Notes

Multi-Mono Plug-ins in the Plug-in Mixer

Installers for multi-mono channel strip and Bus Compressor 2 plug-ins are provided as they always have been with SSL Native
plug-ins. However, it is important to note the following:

Logic - Multi-mono plug-ins are not supported in the Plug-in Mixer - this is because we are currently unable to retreive the DAW
track name.

Pro Tools - Multi-mono plug-ins can be used but control is restricted to the left-hand 'leg' only.

‘Save As Default' For 360°-enabled channel strips and Bus Compressor 2 Plug-ins

All DAWs recommendation

For some, using the Save As Default feature is a crucial aspect of day-to-day
workflow. This feature allows you to alter the default positions of the channel strip
and Bus Compressor 2 plug-in parameters, so that they load with your favourite
'starting point' settings.

If this feature is essential for you, we recommend that you use the Save As
Default option found in the 4K E / 4K B / Channel Strip / Bus Compressor 2 Preset
Management List and not the DAW's own preset system.

The Pro Tools <User Default> feature is disabled for channel strip plug-ins and
Bus Compressor 2 because it was found to be incompatible with the Plug-in Mixer
system. Please ensure that you use SSL plug-ins' own 'Save As Default' feature.

Use the Channel Strip's own
'Save As Default' feature, instead
of the DAW's.

Not Supported - Mixing VST and AU formats

All DAWs recommendation

The Plug-in Mixer system hooks into special VST3 extensions in order to more tightly integrate with the DAW in Cubase, Live and
Studio One. Therefore, using a mixture of AUs and VST3s in a session is not supported. Stick to only using VST3 channel strips
and Bus Compressors in these DAWSs.
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Transport Control

Introduction

Transport control from UC1 and the Plug-in Mixer.

Please note, these Transport commands are powered by HUI/MCU
commands, so therefore you must follow the Setup instructions
on the pages that follow for the Transport control to work. For
more information on the operation of Transport controls from the UC1

front panel TRANSPORT mode, click the link.

| M Wy ) Iy Iy

oJ//337

SMPTE TIME

Transport Bar - Buttons

You can access the following DAW Transport commands:

Rewind
Forward
Stop
Play
Record
Loop

Transport Bar - Display Readout

Pro Tools

COWBELL

BUS
COMP

<= CONFIRM ROUTING PRESETS

UCT1 front panel Transport Control

The Plug-in Mixer Transport Bar

The Transport Bar

Buttons

The format is determined by what is currently set in Pro Tools itself and cannot be changed from the Plug-in Mixer. The counter will

display one of the following formats:

Bars/Beats
Mins:Secs
Timecode
Feet+Frames
Samples

MCU DAWs

In Logic, Cubase, Live, Studio One, and LUNA the Plug-in Mixer
Transport counter can display a choice of the following formats:

Bars/Beats
SMPTE or Min:Secs Time*

*The format is determined by the DAW Host

k

@ BARS/BEATS

SMPTE TIME

| IR By iy Ny By N |

[ [ e e e Ry |

In MCU DAWSs (Logic/Cubase/Studio One) you can toggle
between Bars/Beats by clicking with the mouse in the
display area, or by triggering the SMPTE/BEATS MCU

command on UF8.
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Plug-in Mixer Transport - Setup

The Transport functionality of the Plug-in Mixer & UC1 front panel is achieved using HUI/MCU commands. In order for it to function,
you must configure a HUI or MCU controller in your DAW. On the following pages are instructions on how to configure a HUI or
MCU controller. Once configured, the CONTROL SETUP page of SSL 360° allows you to choose which DAW the Plug-in Mixer
Transport is linked to. The DAW setup examples that follow presume that DAW 1 (i.e. SSL V-MIDI Port 1) is the DAW for which you
wish to configure the Transport control. For completeness, the table below specifies which SSL V-MIDI ports would be required for
DAW 2 and DAW 3, should you wish for either of those to be driving the Transport commands.

DAW 1 DAW 2 DAW 3
SSL V-MIDI Port 1 SSL V-MIDI Port 5 SSL V-MIDI Port 9

Pro Tools

STEP 1: Open Pro Tools. Go to the Setup Menu > MIDI > MIDI Input Devices...
In this list, ensure that SSL V-MIDI Port 1 is ticked (presuming DAW 1 is being configured to drive the Transport).

STEP 2: Go to the Setup Menu > Peripherals > MIDI Controllers tab. Select HUI Type. Set to Receive From SSL V-MIDI Port 1
Source and then Send To as SSL V-MIDI Port 1 Destination.

STEP 3: In SSL 360°, on the CONTROL SETUP page configure DAW 1 as Pro Tools from the DAW CONFIGURATION drop-down
list and also select DAW 1 (Pro Tools) in the TRANSPORT LINKED TO drop-down list.

Peripherals

MIDI Input Enable T vy T T
Type Receive From Send To #Ch's
w [HUI 7| | SSLV-MIDIPrt1Src”| | SSLVMIDIPrt1Dsti |8 |
SSL V-MIDI Port 1 Source v O o * none - -
|_| SSL V-MIDI Port 2 Source e | none 7 none ¥ none ks b
|:| SSL V-MIDI Port 3 Source #4 - [none ¥| none ¥ none B -
| SSL V-MIDI Port 4 Source
STEP 1 : Enable SSL V-MIDI Port 1 in Pro Tools. STEP 2 : Set up a HUI controller to Receive From

and Send to SSL V-MIDI Port 1.

[ ] [ SSL 360°

CONFIGURATION

TRANSPORT
SETUP

STEP 3 : On the CONTROL SETUP tab, set DAW 1 to Pro Tools in DAW CONFIGURATION and also set TRANSPORT LINKED TO
as DAW 1 (Pro Tools).
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Logic Pro

STEP 1: Go to Preferences > MIDI and select the Inputs tab. In this list, ensure that SSL V-MIDI Port 1 is ticked (presuming DAW
1 is being configured to drive the Transport). Versions of Logic preceding 10.5 may not have the 'Inputs' tab available. If so, you

can skip this step, as all MIDI ports are turned on by default.

STEP 2: Go to the Control Surfaces > Setup. Click New > Install... from the drop-down list in the top-left of the window. From this
list, choose Mackie Designs | Mackie Control | Logic Control and click the Add button. Click on the image of the Mackie Control
that has been added to the window and in the device setup options list on the left-hand side, configure the Output Port to SSL
V-MIDI Port 1 Destination and set the Input Port to SSL V-MIDI Port 1 Source.

STEP 3: In SSL 360° on the CONTROL SETUP page configure DAW 1 as Logic Pro from the dropdown list and also select DAW

1 (Logic Pro) in the TRANSPORT LINKED TO list below.

[®) Preferences

0] ® B o -

General Reset Messages  Sync  Inputs

Deactivate MIDI input ports for MIDI hardware which communicates with other software applications.

On Port
v SSL V-MIDI Port 1 Source

STEP 1 : Enable SSL V-MIDI Port 1 in Logic Pro.

DAW
CONFIGURATION

TRANSPORT
SETUP

[ JoX J Control Surface Setup

Edit v New v
'V Device: Mackie Control
Output Port: SSL V-MIDI Port 1 Destination
Input Port: SSL V-MIDI Port 1 Source
Module: Logic Control
Mackie Control
V1.0
|
Fader Bank Offset: 0
Live Loops Scene Offset: 0 @ Mackie Control
Transport Button Click: v/
Touchless movable faders:

STEP 2: Add a Mackie Control and configure the Output
and Input Port to SSL V-MIDI Port 1.

SSL 360°

STEP 3 : On the CONTROL SETUP tab, set DAW 1 to Logic Pro in DAW CONFIGURATION and also set
TRANSPORT LINKED TO as DAW 1 (Logic Pro).
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Cubase

STEP 1: Open Cubase. Go to Studio > Studio Setup... Click the
+ symbol in the top-left of the window and select Mackie Control
from the drop-down list. Set the MIDI Input to SSL V-MIDI Port 1
Source and set MIDI Output to SSL V-MIDI Port 1 Destination.
Click Apply.

STEP 2: Next, go to Studio Setup > MIDI Port Setup and
deactivate (un-tick) the In 'ALL MIDI Inputs' option for your SSL
V-MIDI Ports and click OK. This will ensure that MIDI Instrument
Tracks set to receive from ALL MIDI Inputs do not pickup MIDI
data.

STEP 3: In SSL 360° on the CONTROL SETUP page configure
DAW 1 as Cubase from the drop-down list and also select DAW 1
(Cubase) in the TRANSPORT LINKED TO list below.

Studio Setup

MIDI Input SSL V-MIDI Port 1
Chord Pads
Chord Pads
MIDI
@ MIDI Port Setup
Remote Devices

Mackie Gontrol 2

MIDI Output SSL V-MIDI Port 1 Destination v

‘Track Quick Controls Add Track Add Track...

VST Quick Controls
Transport ift+F2
Record Time Max
Time Display ift+F3
Video
= Video Player
VST Audio System
Built-in Audio
VST System Link

Audio Invert Phase On/Off

e M
o

STEP 1 : Go to Studio > Studio Setup. Add a Mackie

Control and configure the MIDI Input to SSL V-MIDI

Port 1 Source and MIDI Output to SSL V-MIDI Port 1
Destination.

Studio Setup

Chord Pads SSL V-MIDI Port 1 Source | SSL V-MIDI Port 1 Source | (% Active
g SSL V-MIDI Port 2 Source E SSL V-MIDI Port 2 Source ! x| | Active A
In SSL V-MIDI Port 3 Source SSL V-MIDI Port 3 Source | |X Active /

7 MIDI In__ | SSL V-MIDI Port 4 Source "SSLV-MIDI Port 4 Source | |%X| | Active / [l
® in__| SSL V-MIDI Port 5 Source TSSLV-MIDI Port5 Source ' || _|Active | / ]
Remote Devices In SSL V-MIDI Port 6 Source [SSLV-MIDI Port 6 Source [ (%] | Active
Mackie Control In SSL V-MIDI Port 7 Source . SSL V-MIDI Port 7 Source %| | Active []
sl In [ SSLVMIDI Port  Souree e Dl o e R aat

: n -| ort 9 Source -| ol ource ive
Mo ek Contole In | SSLV-MIDI Port 10 Source / SSL V-MIDI Port 10 Source , % tive m

Bl Transport In__ | SSLV-MIDI Port 11 Source | SSL V-MIDI Port 11 Source | (%] J/Active []
Record Time Max In | SSL V-MIDI Port 12 Source SSL V-MIDI Port 12 Source | |X| /| Active
Time Display

STEP 2 : Disable (un-tick) In 'ALL MIDI Inputs' for SSL V-MIDI Ports

DAW
CONFIGURATION

TRANSPORT
SETUP

SSL 360°

STEP 3 : On the CONTROL SETUP tab, set DAW 1 to Cubase in DAW CONFIGURATION and also set TRANSPORT
LINKED TO as DAW 1 (Cubase).
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Live

STEP 1: Open Live. Go to Preferences > Link MIDL... from the Control Surface drop-down list select MackieControl. Set the Input
to SSL V-MIDI Port 1 Source and set Output to SSL V-MIDI Port 1 Destination.

STEP 2: In SSL 360° on the CONTROL SETUP page configure DAW 1 as Live from the drop-down list and also select DAW 1
(Ableton Live) in the TRANSPORT LINKED TO list below.

[ ) Preferences

|___Show |
MackieControl _v| [SSL V-MIDI Port 1| [SSL V-MIDI Port 1v|

None v| [None v||None
None None v| |None
None v| [None v||None
None v||None

None v||None v||None

V|

|

|

v| [None v

|
| On |
|_On |
| _On |
|_On_|
|_On_|
|_On_|
|_On_|
|_On |
| On |
|_On_|
[_On |
[_On_|

STEP 1 : Go to Preferences > Link MIDI. Choose Mackie Control from the Control Surface drop-down list. Set the Input
to SSL V-MIDI Port 1 Source and set Output to SSL V-MIDI Port 1.

®0oe SSL 360°

DAW
CONFIGURATION

TRANSPORT
SETUP

STEP 2 : On the CONTROL SETUP tab, set DAW 1 to Live in DAW CONFIGURATION and also set TRANSPORT LINKED
TO as DAW 1 (Ableton Live).
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Studio One

STEP 1: Open Studio One. Go to Preferences > External Devices and click on the Add... button. In the Add Device window, select
Mackie Control and set Receive From to SSL V-MIDI Port 1 Source and set Send To to SSL V-MIDI Port 1 Destination. Click OK.

STEP 2: In SSL 360° on the CONTROL SETUP page configure DAW 1 as Studio One from the drop-down list and also select
DAW 1 (Studio One) in the TRANSPORT LINKED TO list below

g

)

Add.

v Notify me

Preferences

STEP 1: Go to Preferences > External Devices and click on the Add button. Add a Mackie Control and set it to

L @ @ OO WLl New Keyboard Device Model
Locations

[ New Instrument
New Control Surface

Audio Setup | External Devices  Advanced
Manufacturer

Send To Recaive From ckTen > Access Device Name
» M Acom Instruments

> AKAI
» M Behringer
»m CME
> Doepfer
»m E-MU
> Edirol
» M Evolution
» M Frontier
> JLCooper Send To
» M Keyfax
> KORG
»m M-Audio
4 % Mackie
Control
B3 control Extender
HUI
> NI

Receive From

Mackie Control
Mackie

Control

Please select Mackie Control
operating mode (hold down

8. Chi + Ch2 SELECT while

turning on).

SSL V-MIDI Port 1 Source

SSL V-MIDI Port 1 Destination

Receive From SSL V-MIDI Port 1 Source and Send To SSL V-MIDI Port 1 Destination. Click OK.

SSL 360°

DAW
CONFIGURATION

TRANSPORT
SETUP

STEP 2 : On the CONTROL SETUP tab, set DAW 1 to Studio One in DAW CONFIGURATION and also set TRANSPORT

LINKED TO as DAW 1 (Studio One).
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LUNA

1. Open the LUNA sidebar by clicking the UA diamond logo on the left of the screen, and clicking Settings, or choose LUNA >
Preferences from the app menu. Click Controllers.

2. In one of the MIDI Control Surface rows, click under Input Device and select SSL V-MIDI Port 1 Source and under Output
Device select SSL V-MIDI Port 1 Destination.

3. Select the box in the ON column to enable the control surface.

4

MIDI CONTROL SURFACES

INPUT VICI OUTPUT DEVICE FOCUS MODULE EXTENDER

SSL V-MIDI Port 1 Source SSL V-MIDI Port 1 Destination

~—  — ~—  —

4. InSSL 360° on the CONTROL SETUP page configure DAW 1 as LUNA from the drop-down list and also select DAW 1 (LUNA)
in the TRANSPORT LINKED TO list below.

[ [ SSL 360°

DAW
CONFIGURATION

TRANSPORT
SETUP

SSL UCI User Guide



Product Overview & Features

REAPER

1.  Open REAPER Preferences and choose Control/OSC/web from the toolbar on the left-hand side.
2. Click the Add button and choose Mackie Control Universal for the Control Surface Mode.
3. Set the MIDI input to SSL V-MIDI Port 1 Source and MIDI output to SSL V-MIDI Port 1 Destination.

'

® Control Surface Settings REAPER Preferences
Control surface mode: Mackie Control Universal 2 Envelope Display Control surfaces/OSC/web control
MIDI input: |SSL V-MIDI Port 1 Source & Automation Mackie Control (dev 10,10)
Mouse
MIDI output: |SSL V-MIDI Port 1 Destination &
Mouse Modifiers
Surface offset (tracks): 0 "
MIDI Editor
size tweak: 9 (leave at 9 unless you know what you're doing) )
v Media
Ignore fader moves when fader is not being touched MIDI
Map F1-F8 to go to markers )
- Video
Ignore global bank offsets (always map to tracks specified)
Import

v Plug-ins

Compatibility
VST
LV2/CLAP Add Edit e (changes will be applied immediately)
ReWire
Control surface display update frequency: 15 Hz (default: 15)
ReaScript
Warn when errors opening surface MIDI devices
Reahiote Close control surface devices when stopped and not active application
oK Cancel Control/OSC/web

Find Cancel

4. In SSL 360° on the CONTROL SETUP page configure DAW 1 as REAPER from the drop-down list and also select DAW 1
(REAPER) in the TRANSPORT LINKED TO list below.

[ ] [ SSL 360°

DAW
CONFIGURATION

TRANSPORT
SETUP
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Digital Performer

. In Digital Performer, go to the Setup menu and choose Control Surface Setup...
2. Click the + button and choose SSL 360 Control from the Driver drop-down box.
3. Make sure Unit is set to Main Unit and then configure the Input Port to SSL V-MIDI Port 1 Source and Output Port to SSL
V-MIDI Port 1 Destination.

Control Surface
Listen to control surfaces in background

Driver Track Filtering

SSL 360 Control Pin to Mixer
Unit Input Port Output Port

Main Unit SSL V-M...Source-1 SSL V-M.. stination

Note: Top to Bottom = Left to Right

Cancel

4. In SSL 360° on the CONTROL SETUP page configure DAW 1 as Digital Performer from the drop-down list and also select
DAW 1 (Digital Performer) in the TRANSPORT LINKED TO list below.

[ JON ] SSL 360°

DAW
CONFIGURATION

TRANSPORT
SETUP
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Bitwig Studio

1. Open the Bitwig Studio Dashboard, select Settings and then choose Controllers from the left-hand side menu.
. Click +Add Controller and choose Solid State Logic from the Hardware Vendor drop-down list.
3. Choose SSL UF8/UF1 by Bitwig. Set the MIDI Input to SSL V-MIDI Port 1 Source and set the MIDI Output to SSL V-MIDI
Port 1 Destination.

SETTINGS

Takeover mode

Controllers
Solid State Logic UF8/UF1

SSL UF8/UF1 by Bitwig v... ~ @ SSLV-MIDI Port 1 Source ~

(2] «@ | SSLV-MIDI Port 1 Destin... ~

Controllers

4. In SSL 360° on the CONTROL SETUP page configure DAW 1 as Bitwig from the drop-down list and also select DAW 1
(Bitwig) in the TRANSPORT LINKED TO list below.

[ ] ® SSL 360°

DAW
CONFIGURATION

TRANSPORT
SETUP
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Troubleshooting & FAQs

UC1 LCD Messages

The UC1 screen will display various messages:

SSL UC1 Logo

This message is displayed when you power up UC1, accompanying the power up/light up sequence.

SSL
UcC1

STATUS ‘Awaiting Connection to SSL 360° Software'

Awaiting Connection To This message means that UC1 is waiting for the SSL 360° software to start running on your computer. You

Sl 360° may see this message appear when logging onto your computer, before the operating system has finished

loading your user-profile and start-up items. You may also see this message if you are yet to plug a USB

cable from your UC1 into your computer.

STATUS ‘No Plug-ins'

No Plug-ins This message means that you are connected to SSL 360° but either the DAW is closed or, the DAW is open

NoPlugins|  PUt with no channel strip or Bus Compressor 2 plug-ins instantiated.

STATUS

'‘Attempting To Reconnect'

Attempting to Reconnect to . . . o H
SSL 360° This message means that communication between SSL 360° and UC1 has been lost. If you experience

this, then check that your USB cable connecting UC1 and 360° has not been removed. Re-connect if so.
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SSL 360° Software Messages

You may encounter the following messages in SSL 360°. Here's what they mean:

If the HOME page of SSL 360° is displaying the message 'NO DEVICES CONNECTED', then be sure to check that the USB cable
from your computer to the USB port on UC1 has not come loose.

(XK ) SSL 360°

Solid State Logic

> SSL ©E0°

NO DEVICES CONNECTED

If the HOME page of SSL 360° is displaying the message 'SOMETHING WENT WRONG... PLEASE EXIT AND RE-LAUNCH SSL
360°', then please quit SSL 360° and re-launch. If that does not work then restart your computer.

LK) SsL 360°

Solid State Logic

= SSL 36

)

SOMETHING WENT WRONG...
PLEASE EXIT AND RE-LAUNCH SSL 360°

About  Export Report
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Troubleshooting & FAQs

SSL Support - FAQs, Ask a Question and
Compatibility

Visit the Solid State Logic Help Centre to check compatibility with your system and find answers to your questions:

= A& https:/www.solidstatelogic.com/support

www.solidstatelogic.com/support

Results

Solid State Logic Help Centre

CQ SSL UC1 Compatibility >

SSLUC1:0S Compa'cibility\s>

Don't forget to register your UC1 for the best possible experience.

Thank you

www.solidstatelogic.com/get-started
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Safety Notices

Safety Notices

General Safety

e Read these instructions.

e Keep these instructions.

e Heed all warnings.

e  Follow all instructions.

e Do not use this apparatus near water.

e Clean only with dry cloth.

e Do not block any ventilation openings. Install in accordance with the manufacturer's instructions.

e Do not install near any heat sources such as radiators, heat registers, stoves or other apparatus (including amplifiers) that
produce heat.

e Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than
the other. A grounding type plug has two blades and a third grounding prong. The wide blade or the third prong are provided
for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of an obsolete outlet.

e  Protect the adapter and power cord from being walked on or pinched particularly at plugs, convenience receptacles, and the
point where they exit from the apparatus.

e Only use the attachments/accessories recommended by the manufacturer.

e Unplug this apparatus during lightning storms or when unused for long periods of time.

e Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way,
such as power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus
has been exposed to rain or moisture, does not operate normally, or has been dropped.

e Do NOT modify this unit, alterations may affect performance, safety and/or international compliance standards.

e SSL does not accept liability for damaged caused by maintenance, repair or modification by unauthorised personnel.

Installation Notes

e When using this apparatus place it on a secure level surface.

e  Always allow free flow of air around the unit for cooling. We recommend the use of rackmount kit available from SSL.

e Ensure that no strain is placed on any cables connected to this apparatus. Ensure that all such cables are not placed where
they can be stepped on, pulled or tripped over.

WARNING: To reduce the risk of fire or electric shock do not expose this apparatus to rain or moisture.
ATTENTION: Afin de réduire les risques de choc électrique,ne pas exposer cet appareil a I'humidité ou a la pluie.

Power Safety

e UCH1 is supplied with an external 12 V DC desktop power supply with a 5.5 mm plug to connect to the unit. A standard IEC
mains lead is provided to power the DC supply however if you decide to use a mains cable of your choice, bear in mind the
following:

1) The adapter power cord should ALWAYS be earthed with the earth on the IEC socket.

2) Please use-compliant 60320 C13 TYPE SOCKET. When connecting to supply outlets ensure that appropriate sized
conductors and plugs are used to suit local electrical requirements.

3) Maximum cord length should be 4.5 m (15").

4) The cord should bear the approval mark of the country in which it is to be used.

e Connectonly to an AC power source that contains a protective earthing (PE) conductor.

e  Only connect units to single phase supplies with the neutral conductor at earth potential.

e Both the mains plug and appliance coupler can be used as the disconnect device, ensure that the mains plug is connected
to an unobstructed wall outlet and is permanently operable.
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Safety Notices

General Safety

ATTENTION! The desktop power supply must always be earthed. Refer to the User Guide for further details.

CAUTION! No user-serviceable parts inside. In the event of damage to the unit or power supply contact Solid
State Logic. Service or repair must be done by qualified service personnel only.

CE Certification

UC1 is CE compliant. Note that any cables supplied with SSL equipment may be fitted with ferrite rings at each
end. This is to comply with the current regulations and these ferrites should not be removed.

FCC Certification

e Do not modify this unit! The product, when installed as indicated in the instructions contained in the installation manual, meets
FCC requirements.

e Important: This product satisfies FCC regulations when high quality shielded cables are used to connect with other equipment.
Failure to use high quality shielded cables or to follow the installation instructions may cause magnetic interference with
appliances such as radios and televisions and will void your FCC authorisation to use this product in the USA.

e This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the
FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with
the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is encourage to try to correct the interference by one
or more of the following measures:

1) Reorient or relocate the receiving antenna.

2) Increase the separation between the equipment and receiver.

3) Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
4) Consult the dealer or an experienced radio/TV technician for help.

Industry Canada Compliance
This Class B digital apparatus complies with Canadian ICES - 003.

RoHS Notice

Solid State Logic complies with and this product conforms to European Union's Directive 2011/65/EU on Restrictions of Hazardous
Substances (RoHS) as well as the following sections of California law which refer to RoHS, namely sections 25214.10, 25214.10.2,
and 58012, Health and Safety Code; Section 42475.2, Public Resources Code.
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Instructions for disposal of WEEE by users in the European Union

The symbol shown here, which is on the product or on its packaging, indicates that this product must not be
disposed of with other waste. Instead, it is the user's responsibility to dispose of their waste equipment by
handing it over to a designated collection point for recycling of waste electrical and electronic equipment. The
separate collection and recycling of your waste equipment at the time of disposal will help to conserve natural
resources and ensure that is recycled in a manner that protects human health and the environment. For more
information about where you can drop off your waste equipment for recycling, please contact your local city
office, your household waste disposal service or where you purchased the product.

WARNING: Cancer and Reproductive Harm - www.P65Warnings.ca.gov

Evaluation of apparatus based on altitude not exceeding 2000 m. There may be some potential safety hazard
if the apparatus is operated at altitude exceeding 2000 m.

Evaluation of apparatus based on temperate climate conditions only. There may be some potential safety hazard
if the apparatus is operated in tropical climate conditions.

© ®Pb |«

Electromagnetic Compatibility

EN 55032:2015, Environment: Class B, EN 55103-2:2009, Environments: E1 - E4.
Electrical Safety: UL/IEC 62368-1:2014.

WARNING: Operation of this equipment in a residential environment could causes radio interference.

Environmental

Temperature: Operating: +1 to 30 degrees Celsius.  Storage: -20 to 50 degrees Celsius.

Further information
For additional information, install and user guides, knowledge base and technical support visit www.solidstatelogic.com
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